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Abstract
To orient themselves in their environment, animals integrate a wide array of external cues, which interact with several internal factors, such as
personality. Here, we describe a behavioral protocol designed for the study of the influence of zebrafish personality on their orientation response
to multiple external environmental cues, specifically water currents and magnetic fields. This protocol aims to understand whether proactive or
reactive zebrafish display different rheotactic thresholds (i.e., the flow speed at which the fish start swimming upstream) when the surrounding
magnetic field changes its direction. To identify zebrafish with the same personality, fish are introduced in the dark half of a tank connected
with a narrow opening to a bright half. Only proactive fish explore the novel, bright environment. Reactive fish do not exit the dark half of the
tank. A swimming tunnel with low flow rates is used to determine the rheotactic threshold. We describe two setups to control the magnetic field
in the tunnel, in the range of the earth’s magnetic field intensity: one that controls the magnetic field along the flow direction (one dimension)
and one that allows a three-axial control of the magnetic field. Fish are filmed while experiencing a stepwise increase of the flow speed in the
tunnel under different magnetic fields. Data on the orientation behavior are collected through a video-tracking procedure and applied to a logistic
model to allow the determination of the rheotactic threshold. We report representative results collected from shoaling zebrafish. Specifically,
these demonstrate that only reactive, prudent fish show variations of the rheotactic threshold when the magnetic field varies in its direction, while
proactive fish do not respond to magnetic field changes. This methodology can be applied to the study of magnetic sensitivity and rheotactic
behavior of many aquatic species, both displaying solitary or shoaling swimming strategies.

Video Link
The video component of this article can be found at https://www.jove.com/video/59229/

Introduction
In the present study, we describe a lab-based behavioral protocol which has the scope of investigating the role of fish personality on the
orientation response of shoaling fish to external orientation cues, such as water currents and magnetic fields.
The orienting decisions of animals result from weighing various sensory information. The decision process is influenced by the ability of the
animal to navigate (e.g., the capacity to select and keep a direction), its internal state (e.g., feeding or reproductive needs), its ability to move
1
(e.g., locomotion biomechanics), and several additional external factors (e.g., time of day, interaction with conspecifics) .
2

The role of the internal state or animal personality in the orientation behavior is often poorly understood or not explored . Additional challenges
3
arise in the study of the orientation of social aquatic species, which often perform coordinated and polarized group movement behavior .
Water currents play a key role in the orientation process of fish. Fish orient to water currents through an unconditioned response called
4
rheotaxis , which can be positive (i.e., upstream oriented) or negative (i.e. downstream oriented) and is used for several activities, ranging
5,6
from foraging to the minimization of energetic expenditure . Moreover, a growing body of literature reports that many fish species use the
7,8,9
geomagnetic field for orientation and navigation
.
The study of rheotaxis and swimming performance in the fish is usually conducted in flow chambers (flume), where fish are exposed to the
10,11
stepwise increase of the flow speed, from low to high speeds, often until exhaustion (called critical speed)
. On the other hand, previous
studies investigated the role of the magnetic field in the orientation through the observation of the swimming behavior of the animals in arenas
12,13
with still water
. Here, we describe a laboratory technique that allows researchers to study the behavior of fish while manipulating both the
water currents and the magnetic field. This method was utilized for the first time on shoaling zebrafish (Danio rerio) in our previous study, leading
to the conclusion that the manipulation of the surrounding magnetic field determines the rheotactic threshold (i.e., the minimal water speed at

Copyright © 2019 Journal of Visualized Experiments

March 2019 | 145 | e59229 | Page 1 of 11

Journal of Visualized Experiments

www.jove.com

14

which shoaling fish orient upstream) . This method is based on the use of a flume chamber with slow flows combined with a setup designed to
control the magnetic field in the flume, within the range of the earth’s magnetic field intensity.
The swimming tunnel utilized to observe the behavior of zebrafish is outlined in Figure 1. The tunnel (made of a nonreﬂecting acrylic cylinder
14
with a 7 cm diameter and 15 cm in length) is connected to a setup for the control of the flow rate . With this setup, the range of flow rates in the
tunnel varies between 0 and 9 cm/s.
To manipulate the magnetic field in the swimming tunnel, we use two methodological approaches: the first is one-dimensional and the second
is three-dimensional. For any application, these methods manipulate the geomagnetic field to obtain specific magnetic conditions in a defined
volume of water—thus, all the values of magnetic field intensity reported in this study include the geomagnetic field.
15

Concerning the one-dimensional approach , the magnetic field is manipulated along the water flow direction (defined as the x-axis) using
a solenoid wrapped around the swimming tunnel. This is connected to a power unit, and it generates uniform static magnetic fields (Figure
2A). Similarly, in the case of the three-dimensional approach, the geomagnetic field in the volume containing the swimming tunnel is modified
using coils of electric wires. However, to control the magnetic field in three dimensions, the coils have the design of three orthogonal Helmholtz
pairs (Figure 2B). Each Helmholtz pair is composed of two circular coils oriented along the three orthogonal space directions (x, y, and z) and
equipped with a three-axial magnetometer working in closed-loop conditions. The magnetometer works with field intensities comparable with the
earth’s natural field, and it is located close to the geometrical center of the coils set (where the swimming tunnel is located).
We implement the techniques described above to test the hypothesis that the personality traits of the fish composing a shoal influence the way
16
17,18
they respond to magnetic fields . We test the hypothesis that individuals with proactive and reactive personality
respond differently when
exposed to water flows and magnetic fields. To test this, we first sort zebrafish using an established methodology to assign and group individuals
17,19,20,21
that are proactive or reactive
. Then, we evaluate the rheotactic behavior of zebrafish swimming in shoals composed of only reactive
individuals or composed of only proactive individuals in the magnetic flume tank, which we present as sample data.
21

The sorting method is based on the different tendency of the proactive and reactive individuals to explore novel environments . Specifically, we
17,19,20,21
use a tank divided into a bright and a dark side
(Figure 3). Animals are acclimated to the dark side. When access to the bright side is
open, proactive individuals tend to quickly exit the dark half of the tank to explore the new environment, while the reactive fish do not leave the
dark tank.

Protocol
The following protocol has been approved by the Institutional Animal Care and Use Committee of the University of Naples Federico II, Naples,
Italy (2015).

1. Animal Maintenance
1. Use tanks of at least 200 L to host a shoal of at least 50 individuals of both sexes in each tank.
NOTE: The density of the fish in the tank has to be one animal per 2 L or lower. Under these conditions, zebrafish will display normal shoaling
behavior.
2. Set the maintenance conditions as follow: temperature at 27–28 °C; conductivity at <500 μS; pH 6.5–7.5; NO3 at <0.25 mg/L; and a light:dark
photoperiod at 10 h:14 h.
NOTE: Identical holding conditions must be used for both the mixed population and the separated proactive and reactive populations.

2. Personality Selection in Zebrafish
1. Prepare and place the personality selection tank in a quiet room (Figure 3) with the same water as used in the maintenance tanks.
2. Place a video camera above or at the side of the tank. Connect the camera to a computer with a monitor located in an area where there is no
visual contact with the tank.
3. Select nine fish at random from the maintenance tank and transfer them to the dark side of the personality selection tank, using a knotless
net.
NOTE: Try to limit the interactions with the tanks and fish to the least amount of time possible. Avoid noise and fast movements. If necessary,
transfer the animals in a small volume transporting tank (about 2 L) with water from the holding tank. To avoid air exposure of animals, use
a 250 ml beaker and gently induce the animal to enter the beaker. Try to minimize the capture time, avoid collecting multiple fish as it might
cause physical damage to the animals and do not hold fish for more than a few seconds in the net as these factors can increase stress.
Fish must be fed ad libitum prior to the transfer to the experimental tank. This limits the possibility that different tendencies of food-seeking
22
behavior would affect the behavior of the individuals during the following experiment . Conduct replicate experiments at the same time of the
23
day. This minimizes variability in the behavior of the experimental groups caused by possible circadian rhythms .
4. After 1 h of acclimatization, open the sliding door.
21
NOTE: Individuals who exit from the hole, exploring the bright side of the tank within 10 min, are considered proactive .
5. After 10 min, gently remove the proactive individuals from the tank and transfer them to the proactive maintenance tank.
21
6. After 15 min, collect the fish that remain in the dark box, which are considered reactive , and transfer them to the reactive maintenance tank.
21
NOTE: Discard fish that move to the bright side of the tank after 10 min . Perform the personality test with nine fish at a time until the desired
number of proactive and reactive fish necessary for the tests described in section 5 are collected. Consistency of the proactive and reactive
personality can be checked regularly using the same approach.
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3. Set up of the Magnetic Field with the One-dimensional Magnetic Field Manipulation

1. Switch on the Power unit (Figure 2A).
2. Place the coiled tunnel in the location where the rheotactic protocol will be performed (section 5) but keep it disconnected from the swimming
apparatus (Figure 2A). Place a magnetic probe connected with a Gauss/Teslameter inside the tunnel and verify which voltage is necessary
to obtain the chosen magnetic field value along the major axis of the tunnel.
NOTE: Because of the magnetic properties of a solenoid, the field is reasonably uniform inside the tunnel; this can be checked by slowly
moving the probe both horizontally and vertically.
3. Disconnect the probe and connect the flow tunnel to the swimming apparatus.
4. Start with the rheotactic protocol (section 5).

4. Set Up of the Magnetic Field with the Three-dimensional Magnetic Field Manipulation
1.
2.
3.
4.

27

Switch on the CPU, DAC, and coil drivers (Figure 2B).
Set the chosen magnetic field on each one of the three axes (x, y, and z).
Place the tunnel in the center of the Helmholtz pairs set.
Start with the rheotactic protocol (section 5).

5. Test of the Zebrafish Rheotaxis in the Flow Chamber
1. Transfer one to five fish to the flow tunnel using a 2 L tank with the sides and the bottom obscured.
2. Turn on the pump and set the flow rate in the tunnel to 1.7 cm/s.
NOTE: This slow-moving water will keep the water in the tunnel oxygenated and it will facilitate animal recovery.
3. Let the animals acclimate to the swimming tunnel for 1 h.
4. Start the video recording of the behavior of the fish in the tunnel.
NOTE: We used a camera (e.g., Yi 4K Action) with remote control (e.g., Bluetooth) and saved the video as .mpg (30 frames/s).
5. Start the stepwise increase of the flow rate according to the chosen experimental protocol (1.3 cm/s in this study; Figure 4).
NOTE: For this protocol, we used low flow rates which, for zebrafish, range from 0 to 2.8 BL (body lengths)/s. These flow speeds are in the
24
lower range of flow rates that induce continuous oriented swimming in zebrafish (3%–15% of critical swimming speed [Ucrit]) . The use of
25
low flow rates (following Brett’s protocol ) is linked to the speciﬁc behavioral characteristics of this species in the presence of water currents.
Zebrafish tend to swim along the major axis of the chamber, turning frequently, even in the presence of water ﬂow, and tend to swim both
24,26
26
upstream and downstream
. This behavior is affected by the water ﬂow rate, disappearing at relatively high speeds (>8 BL/s) , when the
animals continuously swim facing upstream (full positive rheotactic response). Vertical and transversal displacements are very rare.
6. Perform morphometry of the animals (sex and total length [TL], fork length [FL], or BL) on pictures of fish in a morphometric
chamber.
1. Select the appropriate picture.
2. Open the picture in ImageJ.
3. Take note of the sex of the animal (male zebrafish are slender and tend to be yellowish, while females are more rounded and tend to
have blue and white colorings).
4. Click Analyze > Set Scale and set the scale of the image in centimeters, using the whole horizontal length of the tunnel as reference.
5. Click Analyze > Measure and record the linear length of the animal.
6. Calculate its body weight (BW).
NOTE: BW is calculated from sex-FL-BW relationships previously built in the lab or from metadata. The whole procedure avoids
manipulation stress on the animals.

6. Video Tracking
1. Open the video file with Tracker 4.84 Video Analysis and Modeling Tool.
NOTE: If necessary, correct any video distortion using perspective and radial distortion ﬁlters.
2. Click on Coordinate system in the upper menu and set the length units to centimeters and the time units to seconds.
3. Click on File > Import > Video and open one of the videos in Tracker 4.84.
4. Click on “Coordinate axes” and set the reference system to track the position of the fish over time, with the x axis along the tunnel. Set the
origin at the low corner of the downstream ending wall (at the water outlet).
5. Click on Track > New > Point of mass and start tracking one fish at a time. Track the last 5 min of each step that the fish spent at each flow
rate.
6. Advance the video manually at five-frame intervals (0.5 s) and mark the time and position of the animal at each upstream-downstream turn
(UDt; red dots in Figure 5) and at each downstream-upstream turn (DUt; blue dots in Figure 5).
NOTE: Use the ﬁsh eye position as a reference for the ﬁsh’s position. Track the animal’s position using a Point mass. Exclude from the
tracking any period of non-oriented swimming (i.e., maneuvering time).
7. At the end of each tracking session, select the x-values and time values from the table at the bottom-right corner of the software window.
Right-click on the data and click Copy data > Full precision.
8. Save the time values and x-values of all turning positions on a template spreadsheet file to calculate the total upstream time (sum of all the
intervals between UDts and DUts) and the total downstream time (sum of the intervals between DUts and UDt), as well as the values of the
rheotactic index in percentages (RI%) for each flow step (see Figure 5).
NOTE: The rheotactic behavior is quantified by the proportion of the total oriented time that the fish spend facing upstream (swimming or
27
rarely freezing [i.e., they stay still at the bottom of the tunnel] ). This proportion is defined as the RI% (Figure 5).
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Representative Results
As sample data we present results obtained controlling the magnetic field along the water flow direction on proactive and reactive shoaling
16
zebrafish using the setup shown in Figure 2A (see section 3 of the protocol). These results show how the described protocol can highlight
differences in responses to the magnetic field in fish with different personalities. The overall concept of these trials relies on the finding that the
14
direction of the magnetic field relative to the water flow affects the rheotactic threshold in shoaling zebrafish . Thus, as changes in the magnetic
field modulate the rheotaxis, this protocol can be used to assess if the response of zebrafish to magnetic fields differ according to their proactive
28
or reactive personality .
At first, using the dark/bright tank as shown in Figure 3, zebrafish were split into different groups according to their proactive/reactive personality.
Following such a test, shoals of five fish with the same personality were then tested in the solenoid swimming tunnel (Figure 1 and Figure 2A). A
total of 20 fish were tested: two shoals composed of five reactive fish each (10 reactive fish) and two shoals composed of five proactive fish each
(10 proactive fish).
One shoal at a time was video recorded while swimming in the tunnel and the water current was accelerated with a stepwise increase of the
flow rate as schematically shown in Figure 4. The fish were allowed to acclimate for 1 h in the tunnel. After that, we applied the protocol for the
25
quantification of the rheotactic behavior, using a stepwise increase of the flow rate according to the classic Brett protocol . Specifically, the flow
rate increased by 0.4 BL/s every 10 min for a total of seven consecutive steps (Figure 4). The behavior of the zebrafish was recorded throughout
the whole duration of the run in the tunnel (70 min), and the RI value at each step was calculated (see protocol step 6.8).
During the runs in the swimming tunnel, the magnetic field was set at one of the two following conditions: 50 μT downstream (i.e., the horizontal
component [along the x-axis] of the magnetic field had the same direction of water flow) and 50 μT upstream (i.e., the horizontal component
16
of the magnetic field had an opposite direction with respect to the water flow) . The intensity along axes y and z were not affected, as well as
the total intensity and inclination of the magnetic field vector. Each shoal of five fish was exposed to only one of the two magnetic conditions.
For example, considering proactive fish, one proactive shoal had the magnetic field directed downstream and the other proactive shoal had the
magnetic field directed upstream.
The videos were then analyzed with the video-tracking software (section 6 of the protocol). The fish were video recorded for the whole duration
of the run in the swimming tunnel. However, only the last 5 min of each 10 min-long stepwise increase of flow rate (Figure 4) were tracked.
During the tracked time, the turns of each fish at each flow rate were highlighted (Figure 5, red and blue data points). These were then used as
references to calculate the RI of each fish and each flow speed (Figure 5). The RI index ranges between 0% and 100%. When below 50%, the
RI index indicates that the fish displayed negative rheotaxis (prevalence of downstream swimming); when the RI is higher than 50%, it shows
that the animal had a positive rheotactic response (prevalence of upstream swimming). An RI not significantly different from 50% would indicate
an absence of rheotactic response. The values of RI% of all the five fish in a shoal were then averaged at each flow rate. These averaged data
were arcsine transformed and used to fit the curves displayed in Figure 6A. Thus, the rheotactic index increases sigmoidally when the water
speed increases, allowing the quantification of the rheotaxis with a simple mathematical method. The relationship between the RI and the flow
rate can be fitted to the following logistic-sigmoidal model.
Three parameters and their variability can be derived from the fit curve. The RIplateau measures the maximal tendency of the animals to orient
upstream in the range of flow rates used in the experiment. RIbottom is the RI value in the absence of water flow and, hypothetically, should not
differ from 50%. Rtr is the is the flow rate at which the maximum slope of the curve occurs, and it can be used as a measure of the rheotactic
6
threshold .
The results indicate that the rheotactic threshold (Rtr) of zebrafish is very low, in the range of a few centimeters per second. Variations of the
magnetic field do not affect the Rtr of proactive fish (no effect of the magnetic field, t-test, P > 0.05). Oppositely, magnetic field changes have a
pronounced effect on the rheotactic behavior of reactive zebrafish. When the magnetic field component along the swimming tunnel was directed
downstream, the Rtr is very low and similar to that of proactive fish. The threshold was significantly higher when the magnetic field was directed
upstream (t-test, P < 0.01).
The RIplateau value of reactive animals was significantly lower when the magnetic field was directed upstream (t-test, P < 0.01). This result
indicates that with these conditions, reactive fish would reach the full positive rheotactic response (RI = 100%) only at very high flow rates. Thus,
this result highlights that, compared to Rtr, RIplateau provides less information about the swimming behavior of the fish. In fact, based on the
strong difference in the reactive RIplateau between the two magnetic conditions, we can state that, under the upstream-oriented magnetic field, the
reactive animals will probably display a full rheotactic response at a higher water flow.
RIbottom values tend to be higher (although not significantly) than 50% in the proactive animals and in the reactive animals exposed to a
downstream-oriented magnetic field. This may indicate a bias in the protocol since the animals characterized by a very low threshold may
remember the flow direction experienced during acclimation. A proper protocol could be devised to test this possibility.

Copyright © 2019 Journal of Visualized Experiments

March 2019 | 145 | e59229 | Page 4 of 11

Journal of Visualized Experiments

www.jove.com

Figure 1: Simplified representation of the swimming tunnel apparatus utilized in the present study. Please click here to view a larger
version of this figure.
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Figure 2: Setup for magnetic field control. (A) Rendering of the swimming tunnel with a solenoid for the induction of a static, horizontal
magnetic field within the tunnel. The solenoid (0.83 turns/cm) is connected to a power unit and it generates fields in the range of ±250 µT
(intensity range that includes the earth’s magnetic field range). On the right-hand side, a photo of the solenoid tunnel connected to the swimming
apparatus is shown. The tunnel is made of acrylic and it has two perforated acrylic plates placed at the water inlet, which guarantee the flow to
be close to laminar. (B) Diagram and photo of the three orthogonal Helmholtz pairs set for the control of the magnetic field in the geomagnetic
range of intensities. The magnetic field probe, the CPU, the digital-to-analog converter, and the coil drivers used to close the loop are also
shown. Each pair of coils is composed of two circular coils with a radius (r) of 30 cm and N = 50 turns of AWG-14 copper wires. A three-axes
magnetometer (sensor) with selectable scale (± 88 µT to ± 810 µT) is placed close to the center of the coil set. The sensor range is set to
values ranging to ±130 µT. These values were also used for the measurements described in the representative results (in these conditions, the
nominal sensor resolution is about 0.1 µT). The intensity and the direction of the magnetic field are controlled with a digital feedback system. The
sensor measures the three components of the magnetic field vector (the three axes), and the corresponding error signals are extracted. Then,
the correction signals are generated by a simple integrator filter. The digital correction signals are converted to voltage by a digital-to-analog
converter and amplified by a suitable coil driver. These last signals are used to drive the Helmholtz pairs. The sampling frequency is fixed to 5 Hz
and the unity gain frequency of the loops is about 0.16 Hz. Once the currents in the Helmholtz pairs of the coils are set, the total magnetic field
varies less than 2% from its mean intensity value in the central cubic volume (with edge [L] = 10 cm) of the coils. During the measurements, the
magnetic field rms is less than 0.2 µT. In both the setups (panels A and B) a static electric field is generated by the current in the coils producing
16
the magnetic field . The intensity of the electric field is about 0.4 V/m when the maximum current is applied; this value is negligible compared to
17
natural or artificial static fields present in the environment whose intensity is of the order of 1 kV/m . Please click here to view a larger version of
this figure.
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Figure 3: Schematic representation of the tank (40 cm x 40 cm x 40 cm) used to separate proactive from reactive zebrafish individuals
21
(not in scale), according to Rey et al. . The volume of the personality selection tank is 50 L. Half of the tank was occupied by a dark box with
a hole of 5 cm in diameter on the side of the box facing the bright half of the tank. The hole was covered by a sliding door (not shown), whose
opening signed the start of a selecting trial. The dark side of the tank needs a removable cover to allow access of hand nets. This facilitates
placing or catching fish before and after the behavioral trials. Please click here to view a larger version of this figure.

Figure 4: Diagram of the flow rates used during the tests to determine the rheotactic threshold of zebrafish. The flow during the 1 h
acclimation period was enough to guarantee an adequate oxygen supply to the animals. It can be assumed that, with this design, oxygen supply
is never a limit, even in the first 10 min step with flow 0. Indeed, with an oxygen content of water at 27 °C of about 7.9 mg/L and an animal
29
oxygen consumption of 1 mg/h.g (an excess approximation for zebrafish oxygen consumption both under routine conditions [Uliano et al. ] and
30
at low-speed swimming [Palstra et al. ]), it is possible to calculate that, in the absence of flow, the Po2 in the flume will not decrease more than
14
2% per animal, remaining well above the critical Po2 (about 40 torr for zebrafish). This figure has been modified from Cresci et al. . Please click
here to view a larger version of this figure.
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Figure 5: Animal behavior in the tunnel and the calculation of RI. The graphs present the position of an individual animal along the x-axis
during a 300 s record at three values of flow rate. The red dots represent the downstream-to-upstream turns, the blue dots the upstream-todownstream turns. The corresponding time intervals spent by the animals downstream or upstream are also reported, and the total upstream and
downstream times are reported, from which an RI value can be calculated. It can be observed that when increasing the flow rate, the upstream
time and the RI values increase. Please click here to view a larger version of this figure.
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Figure 6: Representative results. (A) Relationship between arcsine-transformed RI values (RI is the percentage of the total oriented time that
fish spend facing upstream) and the flow rate for proactive and reactive shoaling zebrafish under two magnetic field conditions along the flow
rate direction (one-dimension control). Each data point is the average of the RI values of the five fish composing the shoal, at each flow rate.
14
Significant differences between curves were tested via a sum-of-squares F-test (alpha = 0.05) . (B) Magnetic field axes and direction of the
water flow in the tunnel. A three-dimensional representation of the magnetic vectors in the two magnetic field conditions used in this study is also
16
shown. The magnetic field in the lab (40°N, 14°E) was: F = 62 μT; I = 64°; D = 44°. This figure has been modified from Cresci et al. . Please
click here to view a larger version of this figure.

Discussion
The protocol described in this study allows scientists to quantify complex orientation responses of aquatic species resulting from the integration
between two external cues (water current and geomagnetic field) and one internal factor of the animal, such as personality. The overall concept
is to create an experimental design that allows scientists to separate individuals of different personality and investigate their orientation behavior
while controlling separately or simultaneously the external environmental cues.
The protocol described in this study, together with the mathematical definition of the rheotactic index (RI), was designed following preliminary
observations of the behavior of zebrafish in the swimming tunnel. When placed in a tunnel, these animals display two types of behavioral
patterns, both in the absence or presence of water ﬂow: oriented swimming and maneuvering. They spend the majority of the oriented time
(usually, the fish were video recorded for more than 95% of the time) swimming along the tunnel (i.e., oriented along the long axis with an angle
lower than 45°), back and forth, turning in proximity of the end walls and often showing thigmotaxis (i.e., swimming close to the walls of the
27
tunnel) .
For this protocol to be successful, it is important that whoever performs the experiment pays attention to the stress of the animals. The
transportation of the fish between the experimental setups must be executed with care. The usage of hand nets should be as quick as possible,
and some training before the actual experiment is highly recommended as zebrafish are fast swimmers and hard to catch in a tank. Stress can
27
dramatically affect the behavior of these animals, and in the case of zebrafish, it can significantly change their swimming behavior . This would
probably affect the results, as fish might display hyperactive behavior and be less sensitive to water flows and magnetic field changes. Contact
with the animals in the experimental setup should be as quick and short as possible. The behavioral analysis requires remote observation, which
also requires practice. Moreover, it is important to analyze the videos blindly (i.e., without knowing protocols and treatments).
5,10,11,31

The rheotactic behavior of many species of fish has been studied using swimming tunnels
. Numerous previous studies focused on the
estimation of the swimming speed that fish can sustain until exhaustion, which is defined as Ucrit, mostly to test physiological and ecological
11,32,33
hypotheses
. The method described in this study focuses, instead, on the rheotactic behavior at low flow speeds. This choice was made
because the objective of this study is to assess the sensitivity to a subtle and weak cue like the magnetic field through the observation of a wellknown and robust orientation behavior of fish, the positive rheotaxis. In the representative results reported here, zebrafish displayed a very
low rheotactic threshold (only a few centimeters per second). This observation could be ecologically relevant for this species, which inhabits
34
environments where the speed of water currents can significantly vary. Zebrafish live both in turbulent rivers and in water bodies where the
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water moves slowly, such as paddies, ponds, and floodplains . When water moves slowly, the ability to detect and orient at low flow speeds (a
low rheotactic threshold) could possibly be advantageous, as the rheotactic response increases the chances to intercept downstream-drifting
36
37
prey and provides directional stimuli for migration .
These observations could not be made using flows with high rates. These would elicit a strong locomotory response that would depend more on
the body conditions and high swimming performances of the animals rather than external cues like the magnetic field. The protocol presented
here was applied on zebrafish, but it is likely suitable for any freshwater or marine species that inhabit environments with moving water and can
be handled in laboratory conditions.
However, this protocol presents some limitations. While it clearly highlights whether a species is sensitive or nonsensitive to magnetic fields, it
cannot reveal the orientation mechanisms through which the animal uses magnetic fields for movement decisions. In order to investigate the
7,38,39
13
magnetic orientation mechanisms in aquatic species, setups with circular arenas and still water
or mazes are commonly used. However,
fish (and aquatic animals in general) do not live in environments where currents are absent, and the presented method is a first attempt to
investigate the integrative behavioral response to ubiquitous directional cues, like water flows and magnetic fields. Another limitation of this
protocol is the manual video-tracking procedure. Integrating this setup with an automatic tracking software would improve the timing of the whole
data analysis process.
The experimental protocol presented here is the first one designed to investigate the influence of animal personality on magnetic sensitivity
and rheotaxis. This topic has been overlooked in the literature and needs to be further explored. Individuals from the same species, or even
22,40
within a population or small group (such as a fish shoal), are characterized by different personality traits
, which can be an important factor in
studies on migratory, exploratory, navigation, and orientation behavior. Not all the individuals integrate the environmental cues in the same way.
Thus, taking into account internal factors, such as personality, could help to reduce the data variability which is commonly observed in studies on
16
movement ecology .
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